Read Me

Pro Tools 10.3.1 and Pro Tools HD 10.3.1 on Mac OS X

10.6.x, 10.7.x and 10.8.x

This Read Me documents important compatibility information and known issues for Pro Tools 10.3.1 and Pro Tools HD 10.3.1
software on computers running Mac OS X 10.6.x (“Snow Leopard”), 10.7.x (“Lion”) and 10.8.x (“Mountain Lion”).

Compatibility
Avid can only assure compatibility and provide support for qualified hardware and software configurations.
For the latest compatibility information—including qualified computers, operating systems, and third-party products—visit the
Avid website (www.avid.com/compatibility).

All Pro Tools Systems
An iLok must be connected at all times while running Pro Tools

Pro Tools requires that an iLok with the appropriate authorizations be connected to the computer at all times. Do not remove the iLok
while running Pro Tools. If the iLok is removed while Pro Tools is running, one of the following will occur:
Pro Tools displays a dialog giving you the following choices:
• Reinsert the iLok and click Save. Pro Tools saves the session and then quits.
• Click Quit. Pro Tools closes the session without saving and then quits.
– or –
Pro Tools displays a dialog giving you the following choices:
• Reinsert the iLok and click OK to continue working in Pro Tools.
• Click Cancel. Pro Tools closes the session without saving and then quits.
QuickTime Player is not currently compatible with Avid Audio Interfaces on Mac OS X 10.8 (PTSW-163965)

QuickTime Player does not currently support Avid audio devices as output devices with Mac OS X 10.8. Audio will not pass through
and playback will not start. Please use an alternate audio interface for QuickTime Player, or use another software solution for playing
back QuickTime files with Avid audio devices as a workaround for this issue.
Mixer and Elastic Audio plug-ins from lower versions of Pro Tools are not compatible with Pro Tools 10 (PTSW-136983)

The Mixer and Elastic Audio Plug-ins from lower versions of Pro Tools are not compatible with Pro Tools 10.x. If you encounter an error indicating that these plug-ins are corrupted please re-run the Pro Tools 10 installer to ensure that the correct plug-ins are installed.
Pro Tools cannot record to drives formatted as Case-Sensitive (PTSW-64502)

Pro Tools cannot record to Mac OS X drives which have been formatted as “Case-Sensitive.” Format the Mac OS X record volumes as
“Mac OS X Extended (Journaled)” in order to record properly.

Pro Tools 10.3.1 and Pro Tools HD 10.3.1 on Mac OS X 10.6.x, 10.7.x and 10.8.x — 9/21/12

1

Spotlight indexing can interfere with long record passes (97151)

There are known incompatibilities with Spotlight indexing drives while recording audio. If you will be recording to a large number of
tracks for over an hour, set all of your drives to private in the Mac OS X System Preferences to ensure maximum performance. Failure
to do this may result in Pro Tools reporting an error and ending the record pass when Spotlight indexes the drives.
Mac OS X 10.7.x - 10.8.x keyboard shortcuts for Mission Control conflict with Pro Tools keyboard shortcuts

By default, Mac OS X 10.7.x and 10.8.x use Control + Arrow keys to open Mission Control and Application Windows. These keyboard
shortcuts conflict with the Pro Tools keyboard shortcuts for changing track display height. You can disable or reassign these shortcuts
in Mac OS X.
To disable or reassign keyboard shortcuts in Mac OS X:
1

From the Apple menu, choose System Preferences.

2

Click Keyboard.

3

Click the Keyboard Shortcuts tab.

4

Disable or reassign the shortcut for Mission Control.

In Mac OS X 10.7.x - 10.8.x, the Library folder in each User folder is hidden

DigiTrace logs, which can be helpful in troubleshooting Pro Tools errors, are stored in User/Library. These logs will be more difficult
to find if the Library folder is hidden.
To find the Library folder:


Go to the Finder and click the Go menu while holding the Option key. Library will appear in the menu while the Option key is held.

To display all hidden files and folders in an Open dialog:


Press Command+Shift.

To permanently unhide the Library folder:
1

Launch Terminal.

2

Type: chflags nohidden /Users/<Username>/Library.
The hide status of the Library folder may be reset during an OS update.

Pro Tools menus and interface are grayed out on launch (PTSW-18024)

Pro Tools can appear unresponsive at launch, with the menus grayed out and browsers inoperable. This can happen because of Spaces.
If Pro Tools is launched in any other Space than the first one, the Session Quick Start dialog still opens in the first Space. You can temporarily disable Spaces, launch Pro Tools, and disable the Session Quick Start dialog in the Preferences to avoid this problem.
Automatic Update Notification will not connect through a proxy server that requires authentication (108837)

Software Updater will not find an active internet connection when behind a proxy server that requires authentication to gain internet access. To work around this, the client machine with Software Updater needs to be moved out from behind the proxy or the proxy needs
to allow HTTP access via port 80 without requiring authentication.
Ethernet control surfaces may be unable to communicate with Pro Tools when Parallels Desktop for Mac is installed (101232)

If you use an Ethernet control surface (such as C|24) or work surface (such as D-Control or D-Command) with Pro Tools,
Parallels Desktop for Mac may prevent communication with the surface. Uninstall Parallels for your computer to restore
communication.
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Co-installation of Pro Tools with Media Composer (PTSW-161947)

If you are running Media Composer 6.x on the same computer with Pro Tools 10.x using HDX, TDM, or HD Native hardware, make
sure to install Media Composer 6.0.1.1 or later.
Launching Pro Tools on OS X managed accounts with parental controls (PTSW-158757)

Observe the following steps to ensure that Pro Tools launches correctly on OS X Managed Accounts with Parental controls:
1

After installation, launch Pro Tools on an Administrator Account before attempting to launch on a Managed Account. Otherwise, you
may need to reinstall Pro Tools.

2

Restart the computer and log into the Managed Account.

3

When launching Pro Tools, you may encounter a series of warning dialogs. Observe the following steps to dismiss them:
• If you encounter the warning: “You don’t have permission to use the application Pro Tools,” choose “Always Allow” and enter
your Administrator name/password.
• If you encounter the warning: “Error trying to communicate with DigiShoe Tool. This could indicate a permissions problem with
the installation. Try a clean reinstall (-9169),” click OK to dismiss the error. Pro Tools will not launch.
• If you encounter the warning: “You don’t have permission to use the application DigiShoe Tool,” choose “Always Allow” and enter your Administrator name/password.

4

Launch Pro Tools. The preceding steps are only necessary the first time you attempt to launch on the Managed Account.

HDX Hardware Accelerated Systems
Some Mac Pro computers with certain video cards may not have power connections available for HDX cards (PTSW-156651)

Some video cards require power from the motherboard, which is also a requirement for Avid HDX cards. If you have a video card that
requires both power connections on the motherboard, a power connection for your HDX cards will not be available. To avoid this problem, use a video card that does not require more than one power connection to the motherboard.

Pro Tools|HD Systems
Slot order for BlackMagic Design DeckLink Extreme II PCIe card and Pro Tools|HD PCIe cards (106661)

BlackMagic Design recommends placing the DeckLink Extreme II video playback and capture card in Slot 3 of your PCIe Macintosh.
You may have difficulty placing the HDMI daughter card in an unused slot between slots 0 and 1 in your Power Mac computer due to
the full size of Pro Tools HD cards. In order to accommodate an additional Pro Tools|HD Accel card, the DeckLink Extreme II was extensively tested in PCIe slot 1 as well. No decrease in performance was found.

HD Native Systems
With Mac OS 10.6.8 or higher, it may not be possible to update the firmware on an HD Native PCIe card (PTSW-146374)

When launching Pro Tools HD with a HD Native card on Mac OS 10.6.8 or higher, a –1164 error may occur. This error indicates that
the firmware for the HD Native card cannot be updated from version 1.0 to version 1.02 or 1.03. If this error occurs, you can only update
the firmware using Mac OS X 10.6.7 or lower. The firmware update can also fail when using a Thunderbolt MacBook Pro. To avoid this
error, use a Mac without Thunderbolt and use the Avid NativeCardFlasher utility to update the HD Native firmware,
For more information on updating Native card firmware, refer to the following Avid Knowledge Base articles:
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=419331
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=429831
HD Native card should be installed in PCIe slot 3 or slot 4 of Woodcrest and Clovertown Mac Pro computers for optimum
performance (PTSW-1771)

Clovertown and Woodcrest Mac computers cannot support a PCIe device of speed greater than 1x in PCIe Slot 2 without PCIe Slot 1
being lowered to 8x. (Note that Avid does not test graphics cards at less than their ideal speed of 16x.) To avoid this problem, install your
Pro Tools Native card in PCIe slot 3 or slot 4 of your Clovertown or Woodcrest era Mac computer.
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Clovertown Mac Pro computers do not have the PCIe bandwidth required to use more than two 4x PCIe cards at full speed
(PTSW-1657 and PTSW-1456)

Clovertown Mac Pro computers with an ATTO UL5D card, a BlackMagic Design's Decklink 3 Video Capture card, and an HD Native
card do not have the PCIe Bandwidth required to run all three cards at full speed. In this configuration, three 4x PCIe cards are being
called for, while Clovertown Mac Pro computers can only accommodate two 4x cards and one 1x card. Consequently, one card must
be run at less than full speed. Avid has not tested any down-throttled combinations and as such this is an unsupported configuration.
Consider the following options as workarounds: slow down the built in graphics card to 8x or remove the SCSI HBA card and use SATA
instead of SCSI drives.
Similarly, an HD Native card, an ATTO Celerity ES-41 Fiber Optic Network Adapter card, and a BlackMagic Design's DeckLink 3 card
cannot be combined in Clowertown era Mac Pro without one card being used at less than its optimal PCIe bandwidth. Since Pro Tools
support for Unity MediaNet 5 is limited to push/pull scenarios, Avid recommends that the ATTO Celerity card be down-throttled by installing it in the 1x PCIe slot, and that the HD Native and DeckLink 3 cards be installed in the 4x PCIe slots.
Avid strongly recommends against running the HD Native card or BlackMagic Design DeckLink 3 card at less than full speed.
VENUE 2.9.1 systems with two HDx Option Cards may not be recognized by Pro Tools HD Native systems (PTSW-142834)

If a second HDx Option card is installed in a VENUE 2.9.1 system, it may cause both HDx cards not to be recognized by Pro Tools on
HD Native. A single VENUE HDx Option card is recognized properly by Pro Tools on HD Native, so for consistent performance it may
be necessary to de-install the second HDx card.

Issues Resolved in Pro Tools 10.3.1
Unwanted data is no longer appended to the end of record passes under certain conditions. (PTSW-170032)
On Pro Tools HDX systems, 176.4/192kHz sessions are now free of unwanted noise in some specific mixer configurations.
(PTSW-166529)
When zoomed into the sample level, waveforms whose clip start is off-screen now draw accurately (instead of one sample late).
(PTSW-162497)
Clicking the Automation Follows Edit button now correctly causes the current selection to update to reflect the new state of the
button. (PTSW-170044)
Automation breakpoints outside of a pasted selection area that match the edge values of the pasted automation (redundant
breakpoints) are no longer modified when pasting. (PTSW-171725)
AudioSuite operations using the “Whole File” parameter no longer result in unwanted changes to audio data or cause Pro Tools
to quit unexpectedly. (PTSW-170456, PTSW-170920)
In Dynamic Transport mode with Link Timeline and Edit Selection enabled, the playhead no longer moves to beginning of the
selection. (PTSW-172367)

Issues Resolved in Pro Tools 10.3
Display
Waveforms are now drawn correctly in the Fades dialog when the start or end points are moved in from the edges.
(PTSW-157852)

Playback and Recording
A class of unexpected 9092, 9093, 9128, or 9129 errors no longer occurs. An error that caused the counters to incorrectly
indicate a very high speed of playback or record no longer occurs. (PTSW-163794)
Input meters on HDX systems now properly indicate clipping. (PTSW-165661)
Scrubbing on tracks above 192 voices on HD Native no longer causes Pro Tools to quit unexpectedly. (PTSW-171347)
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Destructive Punch
Magic ID error is no longer encountered when using Destructive Punch in certain situations. (PTSW-156797)
Destructive Punch now works properly with interleaved audio files. (PTSW-163841)

Automatic Delay Compensation
Delay Compensation may now be enabled for plug-in sidechains in the Operation preferences. (HDX hardware-accelerated
systems only).

Automation
Nudging automation selections now maintains automation shapes inside and outside the selection by inserting anchor
breakpoints at the selection edges. (PTSW-170098, PTSW-170102)
Glide automation correctly glides between values in a selection. (PTSW-166746)
Automation data can be pasted correctly when Automation Follows Edit is disabled. (PTSW-164539)
Pasting automation selections no longer creates unexpected ramps. (PTSW-158837)
Trimming clips with automation no longer creates unexpected ramps. (PTSW-168444)
Automation trimming is now limited such that the lowest value can be trimmed up only to the maximum possible value, and the
highest value can be trimmed down only to the minimum possible value. (PTSW-167044)
Spurious -9155 (automation too dense) errors have been resolved. (PTSW-158618)
Performance has been improved in Continuous Scroll mode when using the “All tracks in Volume view” key command
Option + “-” (minus) (PTSW-163652)
Pro Tools no longer quits unexpectedly when coalescing volume automation to clip gain. (PTSW-164914)
Clip gain positions are no longer affected by the padding amount in Compact Audio dialog. (PTSW-163745)

Editing
Nudging audio within a region no longer affects audio on undisplayed alternate playlists. (PTSW-138403)
Using the Object Grabber to duplicate one or more clips to a different location on the same track(s), either to the insertion point
or by dragging, now correctly results in only the copied clips being object-selected, and not the originals. (PTSW-167253)
Elastic Audio Commit works correctly when there are tempo changes in the session. (PTSW-165797)

Plug-Ins and Processing
Audio sync issues when rendering clip gain on clips with crossfades have been resolved. (PTSW-170425)
The Right-Click menu is now available for making the input (sidechain) active or inactive. (PTSW-166221)
Key input (sidechain) menu text is now italicized when made inactive with the Control-Command key command. (PTSW-166219)
Do To All and Do To Selected are now available for Key input menu active / inactive state.
Mod Delay III correctly recalls tempo sync settings on session open. (PTSW-165514)
Mod Delay III follows tempo changes correctly in Sync mode. (PTSW-165607)
Mod Delay III note value buttons work correctly in stereo link mode. (PTSW-166842)
Native Instruments Kontakt no longer causes Pro Tools menus to become grayed out. (PTSW-166474)
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An error in “ViewsUOSWindow.MacCarbon.cpp Line 1817” no longer occurs with several third party plug-ins. (PTSW-168032)

System Usage Window
The CPU Usage meter now displays CPU cycles required for communication with the HD Native and HDX PCIe cards. The meter
is more accurate than before with these systems.

MIDI
MIDI data selection is now correctly based on the displayed location of the data, which is dependent on the “Display Events as
Modified by Real-Time Properties” preference. (PTSW-161895)
MIDI CC data now displays correctly when the “Display Events as Modified by Real-Time Properties” preference is changed.
(PTSW-142253)
Selecting notes with the marquee in Notes or Velocity view, after having done so in a previously opened session, will no longer
cause crashes. (PTSW-164990)
A new preference has been added on the MIDI pane under Delay for External Devices: Notes and Controllers. When enabled,
Pro Tools applies Delay Compensation to MIDI notes and MIDI controller data. This is helpful when monitoring external MIDI
devices outside of Pro Tools.

Control Surfaces
The handling of ICON-specific session data has been optimized to improve performance of the Save Session command.
(PTSW-164767)
On ICON worksurfaces, the LFE channel is available in 5.1 mode on the touchscreen surround panner. (PTSW-136779)
On ICON worksurfaces, when using the EQ III AAX plug-in, the “Q” knob for LF and HF bands in the EQ section now adjusts
Q in bell mode correctly. (PTSW-165549)

Video and Synchronization
All Satellite Link and Video Satellite systems now stop on the same location when rewound to the beginning of the session.
(PTSW-161241)
Media Composer now stops in sync when Pro Tools is recording. (PTSW-161353)
Pro Tools stops sending timecode when a played selection ends. Devices receiving timecode stop correctly when Pro Tools
stops. (PTSW-151199)
Locating from a 9-pin controller now reliably updates Pro Tools location. (PTSW-163261)
Spurious timecode values are not sent during certain transport command sequences. (PTSW-167405)
When using BlackMagic video output, 1080p24 and 720p59 formats are now properly set. (PTSW-3099)
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Known Issues
The following section documents known issues you may encounter when using Pro Tools 10.3 or Pro Tools HD 10.3, along with
workarounds if they exist.
For known issues specific to any of the software options for Pro Tools HD, see the Satellite Link Read Me, the Video Satellite
Read Me, or the Video Satellite LE Read Me.

General Pro Tools Issues
Synchronizing to external clock with a different sample rate from the session results in the following error: “The current
playback engine does not support a sample rate of 44.1 kHz” (PTSW-127065)

In certain circumstances, attempting to synchronize to an external clock that has a different sample rate than the session may result in
the following error: “The current playback engine does not support a sample rate of 44.1 kHz.” On Mac OS X, this may be preceded by
the error “Pro Tools has re-set the sample rate of the HW device because it was changed by another application.” If this happens, correct
the sample rate mismatch and re-select the correct clock rate.
Templates retain I/O settings and some preferences, display settings, and window layouts (PTSW-47133)

Pro Tools Session Templates Retain the I/O settings and some of the preferences, display settings, and window layouts from the system
on which the template was created. Consequently, created a new session based on a template restores several session properties from the
original system. These properties are retained by Pro Tools until you change them or another session or template is opened that replaces
them. This also means that if a new blank session is created after using a template, the properties from the template will be used for the
new session.
The properties retained from templates include default track height, view settings, window size and position, and I/O Setup. You can update templates by making the desired changes, using the File > Save as Template command (be sure to select the “Install template in system” option), and then selecting the template you want to replace.
With Mac OS X 10.7.x (“Lion”) and 10.8.x (“Mountain Lion”), the Send To DigiDelivery command in Pro Tools requires a beta
version of DigiDelivery.

The latest production version of the DigiDelivery client application is not compatible Mac OS X 10.7.x (“Lion”) or 10.8.x (“Mountain
Lion”). A beta version of the DigiDelivery client is available for users of Mac OS X 10.7.x. Although it has not been through a full qualification test effort, there are no known issues with this version.
CPU Usage Limit may be reached when Error Suppression is enabled (PTSW-50339)

When enabling Error Suppression at CPU Usage Limit 85% or higher, it may be possible to overload your computer to a point at which
it is no longer recoverable. To avoid this state, keep your CPU Usage Limit set to 80% or lower when Error Suppression is enabled
Screen redraw may slow down at higher CPU Usage Limit settings when Host Engine Error Suppression is on (82915)

In some cases, you may experience a slowdown in screen redraw or background CPU tasks when Host Engine Error Suppression is engaged and the CPU Usage Limit is set to 85 percent or above. If you encounter this behavior while using Error Suppression, open the
Playback Engine Dialog and lower the CPU Usage Limit by 5 to 10 percent.
Session Notes dialog frequently appears when opening sessions (PTSW-163563)

The Session Notes dialog frequently appears when opening sessions, but only reports that some paths are unavailable. You should be
able dismiss the dialog and playback the session without incident, but you may want to check your I/O Setup to insure that only valid
paths are configured.
Opening sessions created with Pro Tools 7.4 or lower (106746)

When opening sessions created with Pro Tools 7.4 or lower in Pro Tools 8.1 and higher, all waveform overviews are recalculated. This
is because Pro Tools now features 16-bit waveform overviews, so all old 8-bit overviews will need to be recalculated. This recalculation
only needs to happen once.
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Using the Save Copy In command to save to session formats lower than Pro Tools 10 converts all audio for sessions with
interleaved files (PTSW-152737)

When saving a Pro Tools 10.x session that has a mix of interleaved and non-interleaved (multi-mono) audio files to a lower session format (such as Pro Tools 7–9 “.ptf”), all audio files are converted (even if they are not interleaved).
Using the Save Copy In command from Pro Tools 10 (.ptx) to Pro Tools 9 and lower session formats cannot link to audio files
with names including certain characters (PTSW-163844)

In sessions containing tracks or files with special keyboard characters—such as “$,” “%,” or “#”—using the Save Copy In command to
save to Pro Tools legacy formats is not supported and may result in problems copying files. To avoid this issue, rename any tracks or
audio files containing special keyboard characters before saving a session in a legacy format.
Clip Groups can be dragged to tracks in Playlist view even though Clip Groups are not supported in Playlist view
(PTSW-152707)

It is possible to drag a clip group to a track in Playlist view even though clip groups are not supported in Playlist view. Normally, when
switching to Playlist view from another track view, any clip groups on that track are automatically ungrouped. While clip groups
dragged to tracks in Playlist view may appear to work properly, it is recommended that you ungroup them while in Playlist view to ensure proper behavior.
When importing session data, automation is replaced instead of overlaid when using Adjust Session Start Time to Match
Source Start Time (PTSW-149273)

Automation can sometimes be replaced instead of overlaid when using Adjust Session Start Time to Match Source Start Time when importing session data. This issue may occur if the source session start time (of the session being imported) is earlier than the current session start time. This issue can be avoided if you instead import the session data from the session with the later start time into the session
with the earlier start time. You must also not enable the Adjust Session Start Time to Match Source Start Time option, and select Maintain Absolute when prompted.
Automation window update when writing automation (PTSW-46747)

When writing automation on Volume, Pan, and so on, the corresponding buttons in the Automation window provide no indication that
automation on the related control is being written. You will need to observe the automation buttons on tracks in Mix or Edit windows
to see an indication that automation is being written.
Automatic Delay Compensation cannot not be applied to tracks recording from different types of sources (PTSW-157960)

Automatic Delay Compensation cannot compensate for cascaded records that use both I/O and bus inputs to recording tracks. An example of this is feeding an audio track (in record) from an audio input, and then bussing the output of the track to another audio track
also in record. The first audio track will be compensated but the second cascaded track will not be. (This is not a common workflow.)
Audio scrubbing is offset by the overall system delay when Automatic Delay Compensation is enabled (PTSW-150138)

With Automation Delay Compensation enabled, when scrubbing audio the output is offset by the overall system delay (displayed in the
Session Setup Window). Large system delays cause a noticeable offset. To avoid this issue, you can disable Automatic Delay Compensation when you want to scrub audio for editing.
DestructivePunch may not behave correctly when using Automatic Delay Compensation (PTSW-157282)

When using the Maximum amount of Delay Compensation, DestructivePunch may not behave correctly. To avoid this issue, do not use
DestructivePunch with system delays over 4,096 samples at 48 kHz, 8,192 samples at 96 kHz, or 16,384 samples at 192 kHz.
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Possible performance issues with waveform overviews (110041, 106801, and 106577)

Calculating waveform overviews in Pro Tools 8.1 and higher may cause some one-time issues with various operations. Once the overviews are calculated, system performance will return to normal. Areas where you may notice this are:
• Legacy Sessions (110041)—When opening Legacy Pro Tools sessions (lower than 8.0) for the first time, if you immediately start
playback, you may encounter various errors advising you to increase the H/W Buffer size, or to delete tracks, or to remove some
Native (RTAS and AAX) plug-ins. This is because Pro Tools is re-calculating waveform overviews in the background. Pausing this
task in task manager, or waiting until this task is complete, will resolve the issue. Once the waveform is calculated, you will not
experience this issue again.
• Playback of Newly Created Clips (106801 and 106577)—You may notice a slight drop in normal playback performance immediately following a record take or after creating or importing new clips. This is because Pro Tools is calculating waveform overviews
in the background. This issue is usually encountered when recording or creating many clips with long durations. Pausing this task
in task manager, or waiting until this task is complete, will resolve the issue. Once the waveform is calculated, session playback
performance returns to expected levels.
• With Pro Tools 10.1.1 and higher, waveform overview calculation is automatically paused whenever the Transport is engaged. You
do not need to manually pause this task in the Task Manager unless you want all tasks paused (such as relinking).
Waveform overviews disappear after editing metadata from the Workspace browser (PTSW-153258)

If you edit metadata from the Workspace browser, audio waveform overviews may disappear from the Edit window. If this occurs, recalculate the waveforms or close and reopen the session. To avoid this issue, edit metadata from the Project browser instead of the Workspace browser.
–9128 or –6031 DAE errors when using Sibelius 7 as a ReWire client with Pro Tools (PTSW-148554 and PTSW-149809)

If you encounter –9128 or –6031 DAE Errors when using Sibelius 7 as a ReWire client with Pro Tools, try increasing the Hardware Buffer Size to 1024 samples in the Pro Tools Playback Engine (Setup > Playback Engine).
Audio clips on tick-based tracks do not play at the correct tempo after opening a Reason song with a different tempo
(PTSW-34086)

Audio clips on tick-based tracks do not play at the correct tempo after opening a Reason song with a tempo that is different from the one
in your session. To correct this, make any tempo change via the Conductor track or the Manual Tempo input and the clips will play back
correctly.
Cannot run Reason or Record as ReWire clients if they have not first been launched and set up as a standalone application
(PTSW-133070)

Reason and Record need to be launched and setup as a stand-alone applications before running them as a ReWire clients with Pro Tools.
Do the following:
• Launch Reason or Record in stand-alone mode and follow the on-screen instructions.
• Quit Reason or Record.
• Launch Pro Tools and insert Reason or Record as a ReWire plug-in on an audio, Auxiliary Input, or Instrument track.
Exporting interleaved BWF files from Pro Tools 10 and importing into Pro Tools 9.0.x and lower may cause Pro Tools to quit
unexpectedly (PTSW-151579)

When exporting any greater-than-stereo multichannel interleaved WAV (BWF) files other than 5.1 from Pro Tools 10 and then importing them into Pro Tools 9.x or lower, Pro Tools quits unexpectedly. To avoid this problem, export audio files for import into lower versions of Pro Tools in another file format (such as AIFF or multi-mono).
Opening a session with a QuickTime movie as a non-administrator user can prevent the movie from playing back (47053)

If you open a session as a non-administrator user and you do not have permissions for the QuickTime movie file, Pro Tools will tell you
that the movie file cannot be found and prompt you to relink. In the relink window the movie can be found and Pro Tools will appear
to relink to it but it will still not play back. For correct playback, make sure you have permission to use the QuickTime movie file.
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Some QuickTime audio formats cannot be imported (58792 and PTSW-52226)

The audio from QuickTime movies with Apple Lossless or AMR audio compression cannot be imported into Pro Tools. Use QuickTime
Pro or another application to convert the audio to another format prior to import.
Apple Lossless codec is not supported for Bounce to QuickTime Movie (PTSW-53198)

Pro Tools 7.3 and higher does not support the Apple Lossless audio codec. Choosing it from the Bounce to QuickTime Movie Audio
Compression dialog will result in a movie without usable audio.
48 kHz Bounce to MP3 in Pro Tools 7.x and higher results in a 44.1 kHz MP3 File (72617)

Bouncing to MP3 while using the “Highest Quality Encoding, Slower Encoding Time” setting with any bit rate other than 320 kbps will
result in a 44.1 kHz file. This is a known limitation of the encoder.
Hourly –9073 errors during recording (PTSW-132654)

If you encounter –9073 disk errors at the same time every hour while recording in sessions with large track counts, you may need to update Mac OS. To avoid this problem, check and install all OS related security updates through Mac Software Update.
With the Pro Tools Web browser, links to external sites do not work as expected (PTSW-145325)

In the Pro Tools Web browser, navigating to external sites using links from Avid web pages (such as links to social networks like
Facebook and LinkedIn) may not work as expected. For the sake of security, the Pro Tools Web browser is restricted to avid.com pages.
If you want to browse sites other than avid.com, or share avid.com pages with friends, use the Launch Page in External Browser feature
to view the page in your default Web browser and navigate from there.

HDX Hardware Accelerated Systems
Pro Tools does not play back when an invalid sync source is selected on SYNC HD (Word Clock or AES/EBU) (PTSW-156651)

When attempting to initiate playback, playback will fail if a SYNC HD is connected to an HDX card and an Avid audio interface with
no connections to either the word clock or AES/EBU ports. Ensure that the clock is set to a working clock source to resolve this issue.
In Avid DigiTest, the reported slot number may not correspond to the physical slot number in the computer (PTSW-155373)

In Avid DigiTest, the slot number reported for Avid HDX cards starts from 0 on up. For example, “Slot 1” does not necessarily correlate
to the first physical slot in the machine. If you have an Avid HDX card that is having problems, match the Serial Number ID on the back
of the card with the Serial Number ID displayed on the Slot Info page in Avid DigiTest.
Pro Tools does not use HDX hardware if a Core Audio application is using HDX hardware (PTSW-155010)

When launching Pro Tools HD on an HDX hardware accelerated system, Pro Tools will use the Pro Tools Aggregate I/O as the Playback
Engine if a Core Audio application has already engaged the HDX hardware. Be sure to quit all Core Audio applications before launching
Pro Tools HD to ensure that Pro Tools HD can use HDX hardware.
With multiple track output assignments, Native AAX plug-ins use more voices than expected (PTSW-156089)

When using Native RTAS or AAX plug-in as the last insert on a track that has multiple outputs assigned, additional voices will be used
for each voiced output assignment. This is because a voice is required for each audio channel routed from the TDM engine to the host
processor and back. To avoid this issue, use a DSP AAX plug-in, such Trim, as the last insert on the track.
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Pro Tools|HD Systems
Unable to open sessions created with Pro Tools 7.4 or lower that use the maximum available DSP in Pro Tools 8.1 and higher
(111490)

Since the surround mixer plug-in is installed by default with Pro Tools 8.1 and higher, some stereo sessions that use mono output paths
may use a different DSP allocation than in Pro Tools 7.4 and lower. Older sessions that use mono output paths and use all of the available DSP and may not open in Pro Tools 8.1 or higher. The workaround is to remove the surround mixer plug-in from the “Plug-Ins”
folder and move it to the “Plug-ins (Unused)” folder so Pro Tools does not use the surround mixer to build your mixer. This should make
the necessary DSP available to open the session.

HD Native Systems
Audible pops and clicks occur when changing buffer sizes (PTSW-125715)

Pops and clicks may occur when changing the Hardware Buffer Size (H/W Buffer Size) in the Playback Engine dialog while monitoring
live audio through HD Native hardware. Avid recommends not changing the Hardware Buffer Size while monitoring live audio to avoid
this problem. If you must change the Hardware Buffer Size while monitoring live audio, be sure to lower the monitoring volume to avoid
any possible damage to your speakers.

HD Native Thunderbolt Systems
HD Native Thunderbolt headphone output stops working when low latency monitoring is enabled (PTSW-169936)

The headphone output on the HD Native Thunderbolt does not function when low latency monitoring is enabled. In this case, use alternative monitoring source such, as an Avid HD OMNI.
HD Native Thunderbolt prevents the computer from waking after sleep (–9171 error) (PTSW-169172)

Pro Tools HD and HD Native Thunderbolt do not support the sleep function of Mac OS X. If encountered, disconnect HD Native Thunderbolt to wake the computer. Disable all sleep functions in System Preferences (except display) and shut down the computer. Reconnect HD Native Thunderbolt and start the computer.
HD Native Thunderbolt reports a clock error at higher sample rates (PTSW-168819)

With some computers, you may encounter an audio clock error when recording at higher sample rates (such as 96 kHz) and with lower
HW Buffer Size settings (such as 128 samples or less). In general, higher HW Buffer Size settings are recommended at higher sample
rates. For example, at 96 kHz, a HW Buffer Size setting of 256 samples or higher is recommended.
HD Native Thunderbolt is only supported as the first or second thunderbolt device in a thunderbolt chain at sample rates up
to 96 kHz, and it must be the only Thunderbolt device in a chain at any sample rate above 96 kHz (PTSW-168229)

HD Native Thunderbolt is only supported as the first or second Thunderbolt device in a Thunderbolt chain at sample rates up to 96 kHz,
and must be the only thunderbolt device in a chain at any sample rate above 96 kHz. Visit the compatibility pages on the Avid website
for more information (www.avid.com/compato).
Pro Tools quits unexpectedly when selecting HD Native Thunderbolt in the Playback Engine (PTSW-167511)

After disconnecting and reconnecting HD Native Thunderbolt from your computer, Pro Tools quits unexpectedly when selecting HD
Native Thunderbolt in the Playback Engine. After disconnecting and reconnecting HD Native Thunderbolt, restart your computer to
avoid this problem.
HD Native Thunderbolt does not pass audio with some third-party applications at certain buffer sizes (PTSW-166134)

HD Native Thunderbolt only supports HW Buffer Sizes of 64, 128, 256, 512, 1024, and 2048 samples. However, some third-party applications (such as Cubase) may let you select unsupported hardware buffer sizes. If an unsupported buffer size is selected, HD Native
Thunderbolt may not pass audio. Select a supported buffer size to correct this issue.
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Using the HD Native Thunderbolt headphone output with surround monitoring (HDM-13)

Headphone monitoring with HD Native Thunderbolt is set to mirror Pro Tools output channels 1 and 2 on the first audio interface. To
use HD Native Thunderbolt headphone monitoring with sessions that use surround formats (such as 5.1),change the surround monitoring path in I/O Setup so that the Left channel is mapped to Output channel 1 and the Right channel is mapped to Output channel 2.

I/O Setup
Session templates retain I/O Settings and some preferences, display settings, and window layouts (111605)

Pro Tools Session Templates retain the I/O settings and some of the preferences, display settings, and window layouts from the system
on which the template was created. Consequently, creating a new session based on a template restores several session properties from
the original system. These properties are retained by Pro Tools until you change them or another session or template is opened that replaces them. This also means that if a new blank session is created after using a template, the properties from the template will be used
for the new session.
The properties retained from templates include default track height, view settings, window size and position, and I/O Setup. You can update templates by making the desired changes, using the File > Save as Template command (be sure to select the “Install template in system” option), and then selecting the template you want to replace.
Master Faders assigned to mapped output busses function only on that specific bus, not for the output channel as a whole
(PTSW-127517)

Because a Master Fader works on a bus, not on an output path or output channel, there may be certain configurations in which the level
sent to the physical I/O is not reflected on any meters in the Pro Tools application. If the configuration includes overlapping output paths
or has multiple busses assigned to a single output path, the overall signal level from these combined sources (including any clipping indication) will only be displayed on the interface itself. You can avoid using multiple output paths or output busses simultaneously by
routing your sources to a single mapped output bus and assign a Master Fader to that.
Overlapping outputs are not supported for AFL/PFL (PTSW-128167)

While Pro Tools I/O Setup lets you select overlapping outputs for AFL/PFL monitoring, overlapping outputs are not supported for
AFL/PFL monitoring. For example, if paths A 3–4 overlap the main path A 1–2, even though you can select paths A 3–4 for AFL/PFL
monitoring, you won’t hear anything when monitoring AFL/PFL on paths A 3–4. You can avoid this problem by using non-overlapping
paths for AFL/PFL monitoring.
Output and Send assignments may not be reactivated if they are disabled and then re-enabled in the IO Setup when DSP Usage
is at its maximum (PTSW-156397)

Disabling and re-enabling an internal or mapped bus in the IO Setup does not guarantee that all associated assignments will be re-activated in a session that is using maximum DSP resources. To re-activate these assignments, save and reopen the session. You can also
avoid this issue by adding additional HDX cards to your system.
IO Setup sets to Pro Tools Aggregate IO after updating HDX card firmware (PTSW-159624)

Pro Tools IO Setup may be improperly configured to Aggregate IO after performing a firmware update on an Avid HDX card. To resolve this issue, quit Pro Tools and delete the “Last Used.pio” file from the IO Settings folder (located in the same folder as the Pro Tools
application). Relaunching Pro Tools will create a default IO setup based on the peripherals connected to your HDX card(s).
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File and Disk Management
Missing files when opening a session that was saved using Save Copy In with Preserve Folder Hierarchy (PTSW-52860)

The Preserve Folder Hierarchy feature is designed so that sessions with media split between multiple volumes can be easily moved between systems while retaining folder hierarchy. In order for media files to be automatically found, manually copy or create a folder at
the root level of each volume with the session name that contains the Audio Files or Video Files folder. Or, manually relink to the missing files at their current location.
Session copy saved with Preserve Folder Hierarchy in which multiple files have the same name does not relink properly
(PTSW-29069)

When saving a session copy with Preserve Folder Hierarchy checked, files with the same name may not relink properly when using
Manual Relink. When opening the session copy, use Automatically Relink to locate the correct files. If the session has already been
opened using Manual Relink and some files are still offline, select Relink Offline in the Project Browser to manually relink the remaining files.

Elastic Audio
When opening legacy sessions (Pro Tools 9 and lower) in Pro Tools 10, any rendered Elastic Audio clips are automatically rerendered (PTSW-139989)

Rendered Elastic Audio clips created in legacy sessions need to be re-rendered for use in Pro Tools 10. Re-render of these files occurs
automatically when the session is opened in Pro Tools 10.
Fades on Elastic Audio-enabled tracks may not regenerate when opening sessions created with Pro Tools 10 in Pro Tools 9.0.x
(PTSW-152949)

When saving a copy of a Pro Tools 10 session to v7-v9 and opening the copy in Pro Tools 9.x, some fades might not be regenerated even
if you select the option to re-generate fades without searching. If this happens, closing and re-opening the session causes the missing
fades to regenerate.
Certain audio files cannot be calculated or cleared of Elastic analysis in the Workspace browser (PTSW-29622)

There are some rare cases where a file will have a file suffix of a file format supported by Elastic Audio (either .WAV or .AIF), but the
Pro Tools Workspace Browser will not allow calculation or clearing of elastic analysis. The browser menu items Calculate Elastic Analysis and Clear Elastic Analysis will be greyed out. In these cases, the file may actually be in a non-supported format. To check the file’s
format, look at the Format column in the Workspace browser. If a file format other than WAV or AIFF is shown (such as QuickTime),
then the file cannot be calculated or cleared of elastic analysis. Note that these non-supported files can still be previewed in tempo, as
well as elasticized once imported into a session.
Tempo maps made from Bar|Beat marker generation in Beat Detective cause Clip Groups in rendered mode to fall offline
(PTSW-34950)

A tempo map made from Bar|Beat Marker Generation in Beat Detective will cause clip groups in Rendered mode to fall offline. The
workaround is to make an edit to the offline clip and then toggle the Elastic Audio from rendered to real-time and then back to rendered.
Maintaining phase coherency with Elastic Audio pitch processing (PTSW-20602)

When there is Elastic Audio Pitch processing enabled on a track, switching from Polyphonic, Rhythmic, or X-Form to Monophonic or
Varispeed can disrupt phase coherency. To preserve phase coherency in this case, be sure to clear all Elastic Audio Pitch processing
from the track before switching to the Monophonic or Varispeed algorithm.
Drift in an audio file may occur when using Elastic Audio and the Monophonic or X-Form algorithms (PTSW-33768)

Drift in an audio clip may occur when using elastic audio depending on how much the clips is expanded or compressed when using the
Monophonic or X-Form algorithms. If you are using elastic audio with material that contains transient information in it that you would
like to keep from drifting, you should use the Polyphonic or Rhythmic algorithms.
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Default Input Gain preference is only for Elastic Audio imported at session tempo (PTSW-34096)

The Default Input Gain preference in the Elastic Audio section of the Processing Preferences page is for Elastic Audio Imported at Session Tempo only. This preference option will not function unless Preview in Context is enabled in Workspace, and/or “Drag and Drop
from Desktop Conforms To Session Tempo” is enabled in the Processing Preferences page.
Displayed Timebase is incorrect after importing Elastic Audio tracks (PTSW-46897)

The incorrect timebase is displayed after importing Elastic Audio tracks to existing tracks with opposite timebase. You will need to manually select the correct timebase for the affected tracks.
Elastic Audio clips on playlist lanes are not rendered (PTSW-47311)

In Playlists View, any Elastic Audio clips on Playlist lanes are not rendered (waveform is “off-line”) when changing the track’s Elastic
Audio processing from Real-Time to Rendered.
Clip Groups containing Elastic Audio are not recognized as Elastic if the Clip Group itself has not had any Elastic functions
applied (PTSW-34335)

If a clip group contains Elastic Audio inside it, but no Elastic Audio operations have been performed on the outermost level of the clip
group itself, then the clip group will not register as Elastic Audio. When used to create a new track, the track will not automatically be
Elastic Audio–enabled, and the elastic audio inside the clip group will be rendered using the default Elastic Audio plug-in for the session. As a workaround, add a warp marker to the clip group to force it to register as an elastic clip. Or, create an Elastic Audio–enabled
track first, then add the clip group to it.
Cannot import Elastic Audio tracks with the Consolidate From Source Media option (PTSW-33894)

Use Copy from Source Media to import Elastic Audio tracks.
Timing inaccuracy in audio files converted from CAF and MP3 with Preview In Context enabled (PTSW-46707)

Audio files converted from CAF and MP3 with Preview In Context enabled can cause timing inaccuracies (gaps in the audio and innerclip asynchronous transients issues). This is inherent with compressed file formats.

MIDI
When recording MIDI, Wait for Note does not respond to MIDI input from ReWire (PTSW-30511 and PTSW-34550)

When performing a MIDI record, Wait for Note will not respond to any MIDI received from ReWire. If you are recording MIDI generated from a ReWire application, you will have to start the transport manually or use a countoff instead of Wait for Note.
When using Import Session Data on a MIDI track with Real-Time Properties enabled and set to using Diatonic transposition,
transposition is based on the first key signature in the session only (PTSW-49297)

When importing session data from a session that includes multiple key signatures and a MIDI or Instrument track with the “Transpose
in Key” Real-Time property enabled, the transposition will be based only on the first key in the session. This can be corrected by toggling the Real-Time Properties off and on; then the diatonic transposition will be correct for each key.

Plug-Ins
For known issues about specific plug-ins, see the Audio Plug-Ins Read Me.
The TDM version of Dyn III Expander/Gate may experience fidelity or routing issues in 192 kHz sessions (PTSW-159677)

Using the TDM version of the Dynamics III Expander/Gate plug-in at 192kHz can cause unexpected behavior, including distortion of
processed audio and unintended routing of audio between tracks using the Expander/Gate plug-in. If this occurs, try quitting and relaunching Pro Tools, or using the RTAS version of the Dynamics III Expander/Gate plug-in.
When opening legacy sessions on HDX systems, the 4-band EQ III plug-in is converted to the 7-band EQ III plug-in

The AAX EQ III plug-in does not have a 4-band option. Pro Tools will automatically convert 4-band EQ III instances into 7-band instances if you are using only AAX plug-ins. If the EQ3.dpm is present in the Plug-ins folder, then the plug-in will be converted to a Native (RTAS) version.
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The EQ III 4-band plug-in is displayed above the 1-band and 7-band version in Pro Tools 10.x

Avid shortened the name of the new AAX version of EQ III to allow for better visibility of the plug-in name in Narrow Mix view as well
as on control surfaces. The (.dpm) TDM and RTAS version name is “EQ III or EQ 3” (with space) whereas the (.aaxplugin) DSP and
Native version is “EQIII or EQ3” (without space).
As a result of this change, when viewing the Native plug-in pop-up menu, EQ 3 4-band (RTAS) will be displayed before the EQ3 1-band
and EQ3 7-band (Native) plug-ins.
Sessions saved in Pro Tools 10.0 or 10.1 with unlinked multi-mono plug-ins may open with the wrong plug-ins inserted
(PTSW-163664)

In some situations, sessions saved in Pro Tools 10.0 through 10.1 will open incorrectly. Sessions saved with unlinked, multi-mono plugins may open with the wrong plug-in on the track Insert. To resolve this issue, open the session in Pro Tools 10.2 or higher, re-insert the
correct plug-in configuration if necessary, and then save the session.
TDM plug-ins cannot be converted to Native AAX format under certain conditions (PTSW-158652)

TDM plug-ins instantiated in a session cannot be converted to Native AAX version if there is no RTAS equivalent of the plug-in and
there are no other Native AAX versions already present in the session. Reverb One is an example of such a plug-in. To avoid this, instantiate a Native AAX version of the plug-in on a spare track, then convert the TDM plug-in to Native format.
On Mac OS X 10.7.x (“Lion”), any custom location for Avid Virtual Instrument content is not remembered

When installing Avid Virtual Instruments, if you choose a custom location for the content, that location is not remembered, resulting in
error messages when you try to use a virtual instrument plug-in (Boom, Mini Grand, or Xpand) that references a “.big” content file. The
location is not remembered after quitting and relaunching Pro Tools.
To avoid this error, move or reinstall the Avid Virtual Instrument content to the default location in the Applications > Avid folder.
Some plug-ins require exclusive use of a DSP chip on HDX hardware-accelerated systems (PTSW-154614)

Certain plug-ins, such as ReVibe and Reverb One, use direct memory access (DMA) on Avid HDX cards. DMA plug-ins cannot share
HDX DSP chips with other plug-ins. Additionally, even though DMA plug-ins of the same type can share a single HDX DSP chip (for
example, multiple ReVibe plug-ins can use the same HDX DSP chip), they must be of the same channel width (DMA plug-ins of the
same type cannot share the same HDX DSP chip if they have different channel widths).
HD Pack, Massive Pack, Mbox Factory, and 003 Factory plug-in bundle installers do not work on Pro Tools 9.0 or higher
(PTSW-134351)

If you install Pro Tools 9.0 or higher on a clean Pro Tools system, and then run HD Pack, Mbox Factory, or 003 Factory plug-in installers
included with lower versions of Pro Tools (such as Pro Tools 8.0.4), they will not be able to install the bundled plug-ins as you might
expect. Visit the Avid website (www.avid.com) to download the latest versions of corresponding installers included with the version of
HD Pack, Massive Pack, Mbox Factory, or 003 Factory that you own. These installers have been updated to run on a Pro Tools 9.0 or
higher system (as long as you have valid licences for each plug-in on your iLok).
Native Plug-in appear unavailable at higher sample rates (such as 192 kHz) (PTSW-160300)

When using some native (host-based) plug-ins at higher sample rates (such as 192 kHz), it may be necessary to lower the number of host
processors in the Playback Engine dialog. This is because in certain situations it is beneficial to leave a CPU Core processor available
for other tasks, and not have the host-processor engine running on all Cores.
Pro Tools stops working when opening a session with Structure Free (PTSW-131965)

When opening a Pro Tools session that uses Structure Free, Pro Tools may hang temporarily if Structure Free is looking for files in a
directory where the files are not present.
Pro Tools quits unexpectedly when creating a new folder on the presets page with Hybrid (PTSW-133279)

When using Hybrid version 1.5.3.10110, Pro Tools may quit unexpectedly when using the New Folder feature on the Presets page.
To avoid this problem, update to the latest version of Hybrid.
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With HDX systems, on tracks that have a mono-to-stereo plug-in, if a stereo native (AAX or RTAS) plug-in is inserted after the
mono-to-stereo plug-in, the resulting stereo signal will be out of phase or diminished in volume. (PTSW-161487)

To avoid this, use a stereo DSP plug-in after the mono-to-stereo plug-in, or reconfigure the track to avoid this signal configuration.
AudioSuite and Clip Groups (PTSW-57457)

AudioSuite plug-ins handle Clip Groups in the Clip List slightly differently than audio files. With audio files, an AudioSuite process can
be applied to all copies of a unique audio file which appear in your session by selecting your target as Clip List in the AudioSuite plugin window and selecting Use in Playlist. However, if your target is set to Clip List in the AudioSuite plug-in window while you have a
Clip Group selected, Pro Tools does not recognize the Clip Group as processable audio and will present a No Audio was Selected error.
This is because a Clip Group is not treated as audio until it is actually used in a track.
To apply an AudioSuite process to all copies of a Clip Group in a session at once, do the following:
1

Select the Clip Group to be processed.

2

From the Clip List menu, select Ungroup All. All elements of the group will remain selected.

3

Perform AudioSuite processing.

4

From the Clip List menu, select Regroup.

5

When prompted, select Modify to apply the AudioSuite Process to all copies of the Clip Group in the session, or Copy to apply it only
to the selected Clip Group.

Plug-In Find and Relink with file types not supported by Pro Tools (111704)

Find and Relink will not be triggered by plug-ins in situations where plug-ins supporting Find and Relink are missing links to file types
that are not natively supported by Pro Tools (such as REX files). To have full Plug-in Find and Relink support, the file types used in
plug-ins must also be supported by Pro Tools.
Software instrument does not emit sound when inserted on an Instrument Track or Auxiliary Input (65797)

Some older software instruments do not emit sound and/or do not play unless they have a valid hardware input or MIDI output assignment. If this problem occurs, manually assign a hardware input to the Instrument track or Auxiliary Input, and/or manually assign a
MIDI output to the Instrument.
After Installing Pro Tools 10, Structure Free appears in the plug-in insert selector Instead of the full version of Structure even
though the full version of Structure was already installed (PTSW-150093)

After installing Pro Tools 10 Structure Free appears in the Plug-in Insert selector instead of the full version of Structure even though the
full version of Structure was already installed on your computer. To correct this issue, quit Pro Tools, delete the DAE preferences located in /Users/<username>/Library/Preferences/DAE Prefs, and then relaunch Pro Tools.
Using the Pro Tools 9.0.5 uninstaller also uninstalls Structure (PTSW-151154)

When using the Pro Tools 9.0.5 Uninstaller to uninstall Pro Tools 9.x, the Structure plug-in is also uninstalled from your computer. To
avoid this issue, do not use the Pro Tools 9.0.5 uninstaller (you do not need to uninstall Pro Tools 9.x before installing Pro Tools 10).
If you encounter this issue, you will need to reinstall Structure after you install Pro Tools 10.
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Control Surfaces
Trim Scrub and Trim Shuttle don’t work on clips with fades (PTSW-46911)

If a clip has fades, Trim Scrub and Trim Shuttle don’t work when trying to trim using a control surface. To work around this problem,
remove any fades on the clip, then execute the Trim Scrub or Trim Shuttle, and then restore the fades.
Used HW output path indication (101095)

In Assign Matrix on your worksurface, Insert mode the used HW output path will not have amber background indicating that it's already
assigned after switching to a different insert on the same track.
Color indication on plug-in controls in Learn mode (102710)

When a plug-in is in Learn mode and the track with this plug-in is not focused on the main ICON unit, all automation LEDs in the Plugin window will be red if the track is in one of auto write modes. This conflicts with red color indication on the Plug-in control, which
is armed for mapping. The workaround is to set the track with plug-ins to Read automation mode.
SignalTools meter ballistics on control surfaces (74340)

SignalTools RMS, VU, BBC, Nordic and DIN meters will display inaccurate decay times when viewed on a control surface. Unaffected
types are Peak, VENUE, and Peak + RMS, which only reports the Peak meter to the control surface. The attack times of the affected meters are not affected, only the decay times. All meter types display accurately in the plug-in window.
Channel Strip plug-in Expander/Gate meters appear in the Compressor/Limiter meter Instead of in the Expander/Gate meter in
D-Control Dynamics section (Main Unit) (PTSW-150897)

The Avid Channel Strip plug-in uses shared meters for Expander/Gate and Compressor/Limiter processing. Because of this, both Expander/Gate and Compressor/Limiter metering appear only in the Compressor/Limiter meter in D-Control Dynamics Section (Main
Unit).
Pro Tools transport must be stopped when recalibrating ICON faders (78074)

The transport in Pro Tools must be stopped when recalibrating faders on D-Command and D-Control. If one or more faders need calibration do the following: Stop playback, enter Utility mode, press TEST, press FADER, and press RECAL. After recalibrating faders.
exit Utility mode.
Adjusting Clip Gain with the Jog Wheel on a EUCON control surface can result in Pro Tools quitting unexpectedly
(PTSW-155028)

Adjusting Clip Gain using the Jog Wheel on a EUCON control surface during playback can result in Pro Tools quitting unexpectedly.
You can avoid this issue by using the mouse or key commands to adjust clip gain instead.
The Edit and Mix window do not follow banking on EUCON control surfaces (PTSW-133466)

When the Edit Window Follows Bank Selection and/or the Mix Window Follows Bank Selection preferences are enabled in Pro Tools
(Setup > Preferences > Mixing), after banking your EUCON controller, neither the Edit nor Mix window scroll to follow. You will have
to manually change the view of the Edit or Mix windows to see the tracks that correspond to the EUCON controller if they are off screen.
Switching applications in Mac OS X 10.7.x (Lion) while using a EUCON control surface can cause Pro Tools to stop working
(PTSW-152800)

On a system running Mac OS X 10.7.x (Lion) with a EUCON control surface, if you are running other applications with Pro Tools,
switching Pro Tools to the frontmost application can cause it to stop working. To prevent this, lock the surface to Pro Tools by doing
the following: In the EuControl application, click the Assign tab. Under EuControl Settings, select “Entire Surface” under “Lock to application” and verify that the control surface is locked to Pro Tools.
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Video
Playback of QuickTime video in Pro Tools may stutter or drop frames

When monitoring QuickTime playback in the Pro Tools Video Window on the computer screen, the video image may stutter or drop
frames. To improve results with QuickTime playback, try any of the following:
• Disable Continuous Scrolling.
• Close unnecessary UI windows.
• Try using the DNxHD codec.
• If you have an available PCIe slot in your computer, try using one of the following:
• A supported Blackmagic video card
• A supported Canopus video peripheral for QuickTime DV playback
• Consider using an Avid option that includes a video solution:
• The Video Satellite option offers guaranteed performance for Avid video playback (QuickTime can also be used via AMA).
• The Video Satellite LE option offers a way to integrate a Blackmagic video card into a system
• The Avid Mojo SDI peripheral offers guaranteed performance for standard-definition Avid video
H.264 video files over 2 GB play back incorrectly (PTSW-158646)

At a certain point during playback, an H.264 video file over 2GB in size will incorrectly restart playback from the beginning, even
though the timeline indicates it is not playing from the beginning. The workaround is to place an edit (break) in the video clip prior to
the point it starts playing incorrectly from the beginning. This issue only affects H.264 files larger than 2GB.
Avid video peripherals are not officially supported with Pro Tools software (PTSW-132918)

When using an Avid video peripheral such as Mojo SDI with Pro Tools, you must have Pro Tools|HD or HD Native hardware with a
SYNC HD or SYNC IO in order to maintain near sample accurate audio/video sync. Alternately, Pro Tools LE hardware containing an
S/PDIF input can be used to resolve the audio clock to the video peripheral. While it is possible to use an Avid video peripheral without
the presence of any hardware (Pro Tools Software only), audio/video sync is not guaranteed.
Video Offset affects Bounce To QuickTime files (PTSW-123033)

If Pro Tools has a defined Video Offset and you Bounce to QuickTime, the resultant QuickTime file will be offset by the specified
amount in Pro Tools (Setup > Video Sync Offset). To avoid this problem, set the Video Sync Offset to 0 before bouncing to the QuickTime file format.
QuickTime Movies with a frame rate of 29.97 and greater that use the Avid DNxHD codec do not play when placed at past 20
hours on the Pro Tools timeline (PTSW-149397)

With Pro Tools 10, the timeline has increased from 12 hours to 24 hours, allowing any timecode stamped media to be placed at its Original TimeStamp location, regardless of the session start time. However, Avid DNxHD encoded QuickTime clips will not play back
when placed anywhere on the Timeline past 20 hours. Please limit use of Avid DNxHD encoded QuickTime clips to the first 20 hours
of the Pro Tools Timeline to avoid this issue.
When using Bounce to QuickTime, do not bounce to an existing movie name (PTSW-53967)

If you use the Bounce to QuickTime command and use the same name as an existing movie, the bounce may fail. It is best to use a unique
name for each bounce, or delete the previous movie from the drive prior to bouncing with the same name (rather than choosing to replace
the existing file).
Closing the QuickTime window during session playback may result in –9092 errors that stop playback (PTSW-162592)

To avoid this issue, try increasing the number of CPU Cores available for Pro Tools processing and/or raise the H/W Buffer Size in the
Pro Tools Playback Engine dialog.
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Pro Tools UI may slow down with densely-edited QuickTime Movie track (PTSW-54496)

Pro Tools may begin to respond more slowly and update less often as a session with one or more QuickTime video tracks becomes more
and more densely edited. If, while working with heavily edited QuickTime clips, Pro Tools responsiveness begins to decline, use the
Bounce to QuickTime Video command, then import the bounced movie.
Unsupported QuickTime video formats (PTSW-52140, PTSW-52155, PTSW-52156, 72961)

Several video formats supported in QuickTime are not supported in Pro Tools. These include .DivX, .flc, .m4v and .3gp format movies.
Attempting to import these will generate errors or will fail to import.
QuickTime clips with “Clean Aperture” settings do not play back in Pro Tools 10 on OS X 10.7 (PTSW-150342)

Pro Tools 10 on Mac OS X 10.7 is unable to playback QuickTime video clips with “Clean Aperture” settings. The session plays back,
but these clips appear black in the Video window. These clips do play back in Pro Tools 10 on Mac OS X 10.6.
Standard definition QuickTime movies rendered as 16:9 Anamorphic play back in Pro Tools at 4:3 (PTSW-23020)

Standard Definition QuickTime movies that are rendered with 16:9 an anamorphic Scaled Size of 853x480 play back in Pro Tools at 4:3
or 720x486 resolution. The Scaled Size attribute of QuickTime movies is ignored by Pro Tools. To work around this problem, render
the movie letterbox natively within the 720x486 pixel dimension.
MPEG-1 and MPEG-2 video freezes at edit points (PTSW-55185)

Editing MPEG-1 & MPEG-2 video is not officially supported. If you experience this problem, try switching playback to the Video window, or convert the movie to a supported format using a 3rd party application. Removing the audio from an MPEG-1 or MPEG-2 movie
with a 3rd party application may also fix the problem.
Audio from “muxed” MPEG-1 and MPEG-2 movies cannot be imported and will be heard in a bounced movie (PTSW-53625)

Unlike other QuickTime formats, MPEG-1 and MPEG-2 movies store audio and video in a single multiplexed track, called a “muxed.”
track. Pro Tools cannot separate the audio from video for these types of movies. As a result, you will not be able to import the audio from
an MPEG-1 or MPEG-2 movie. Also, if you Bounce to QuickTime using an MPEG-1 or MPEG-2 movie as a source movie, the original
audio from the movie will be present in the bounced movie (even though it will not be heard while working with the movie in Pro Tools).
To import audio from an MPEG-1 or MPEG-2 file, use a third party application to “demux” the MPEG stream.
Dragging from Mac Finder in Shuffle mode does not work correctly with video (PTSW-28041)

Dragging a Video file from the desktop to the Edit window while in Shuffle mode will always place the video at session start, overwriting existing video clips in that location.
System instability when running multiple applications using Blackmagic Design hardware for QuickTime video output
(PTSW-19486)

When Pro Tools is running with a Blackmagic DeckLink II Extreme or Intensity video capture and playback PCI-e card installed,
launching Blackmagic Design’s Deck Capture utility, Final Cut Studio, or any other application which supports Black Magic hardware
for video output, can result in system instability. To avoid any potential system instability only use one Blackmagic DeckLink–aware
application at a time.
Clip names appear incorrect after selecting Field Recorder channel matches, or expanding to new tracks. (PTSW-136012)

This can occur if the file name of a Field Recorder channel match contains a hyphen followed by a number greater than zero. Pro Tools
names new clips by incrementing the number after the hyphen. If a field recorder file is already named in this way (such as “Filename01”), then new clips created by selecting a Field Recorder channel match or by expanding a track may have names different from the
parent file. To avoid this situation, avoid using hyphens in Field Recorder file names.
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Field Recorder matches appear offset after AudioSuite rendering if the session timecode rate does not match the file timecode
rate (PTSW-152147)

If a portion of a file has been rendered with an AudioSuite plug-in, an offset can occur when expanding field recorder matches in cases
where the session timecode rate does not match the timecode rate of the audio file. To avoid this issue, you can either render the whole
file with AudioSuite (rather than only a portion of the file), or use Whole File mode when rendering AudioSuite processing.

General Localization
Session notes or Session Info text files saved in Japanese may not open in TextEdit (PTSW-46686)

Session Notes (you can generate these if you are missing plug-ins or have problems when opening a session) or Session Info (File > Export > Session Info as Text) text files may not open in TextEdit, depending on the TextEdit preference settings. This is because the files
use different text encoding. As a workaround, you can use the Console application to open files or you can use the Open menu item in
TextEdit, then choose the correct encoding, as follows:
• Session Notes - UTF-8
• Session Info - Japanese (Mac OS)
Reading session notes on Korean Mac OS X (PTSW-144218)

Apple has changed its default UTF-8 encoding behavior in the latter 10.6.x releases and 10.7.x. Because of this some languages do not
open Session Notes correctly in TextEdit.
To open Session Notes correctly:
1

Launch TextEdit.

2

Choose TextEdit > Preferences.

3

Click Open and Save.

4

Under “Plain Text File Encoding,” set Opening Files to Unicode (UTF-8).

Certain Chinese characters need to be initiated in the Mac OS before they can be used for naming in Pro Tools (PTSW-33074)

If you cannot use certain characters for naming in Pro Tools, use Text Edit in Mac OS X to initiate the characters. In Text Edit, type the
same characters you were trying to use, then use the mouse to select the correct ones from the pop up menu. You should now be able
to use them in Pro Tools.
AAF/OMF sequences with non-English characters import with garbled clip names or won't relink (PTSW-33569, PTSW-99570,
PTSW-33826)

If an AAF/OMF sequence containing files or clip names with non-English characters is exported from a Mac-based Pro Tools 7.3.1 system (or lower), it may not import correctly into Avid Media Composer, or Pro Tools 7.4 and higher systems on Windows or Mac. Conversely, AAF/OMF sequences with non-English characters exported from any Pro Tools 7.4 or higher system (or higher) may not import
correctly into a Mac-based Pro Tools 7.3.1 (or lower) system. To relink the files, select “Manually Find and Relink,” then deselect all
options except “Find by file ID.” Clip names may appear garbled.
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Known Issues with Pro Tools CoreAudio Hardware Drivers
Limitations of the Avid CoreAudio driver with Digi CoreAudio Manager

The Digi CoreAudio Driver has the following limitations with HD, 003, and Digi 002 systems:
Pro Tools HD, and Pro Tools with 003 and Digi 002 systems require exclusive access to Pro Tools hardware. You cannot use CoreAudio applications and Pro Tools with these systems at the same time. To use Pro Tools, make sure you quit any CoreAudio applications
before launching Pro Tools on these systems. To use a CoreAudio application with these systems, make sure you quit Pro Tools before
starting the CoreAudio application.
 The Digi CoreAudio Driver cannot be used to preview sound files from the Mac Finder while Pro Tools is running. When a sound
file is located in the Mac OS X navigation window, a QuickTime transport bar is displayed next to it. The QuickTime transport bar lets
you audition the sound file. With USB audio interfaces, you can preview sound files from the Mac Finder as long as Pro Tools is not running. Regardless, with FireWire and Avid HD audio interfaces, the sound will always play back though the Mac built-in audio controller
(through the Mac speaker or headphone jack). However, if you double-click a sound file, the QuickTime application will launch, which
can use the Digi CoreAudio Driver for playback.

The Digi CoreAudio Driver cannot be used for playback of Mac System Sounds.
Selecting “Digidesign HW” for Sound Input or Output in System Preferences may cause Pro Tools to fail to launch (99576)

If “Digidesign HW” is selected as the input or output device in System Preferences, certain common actions in the Finder may activate
the Digi CoreAudio Manager. These actions include selecting an audio or video file while in Columns view or while the Inspector window is open, or using Get Info or Quick Look on an audio or video file. Once activated, CoreAudio may remain connected even after
selecting a different file or closing all Finder windows. If Pro Tools is launched while CoreAudio is connected, an error message stating
“Digidesign Hardware is in use by another application. (–1133)” may occur.
Pops when changing sample rates

With the Digi CoreAudio Manger, your Pro Tools hardware may produce a “pop” or “click” sound if Pro Tools was last used at a sample
rate different from the one the new CoreAudio client is set to use.
Audio streaming problems when using very low H/W Buffer Sizes with 3rd party Core Audio applications (such as Logic)
(PTSW-154719)

You may experience audio streaming problems when using Avid hardware with 3rd party applications such as Cubase or Logic and
playing back at the lowest buffer size. The lowest supported buffer sizes when using Avid hardware are 64 at 44.1 and 48 kHz sessions,
and 128 at 88.1 and 96 kHz.
Pro Tools hardware may not play sound from QuickTime or Safari with CoreAudio (PTSW-3093 and PTSW-27892)

If you do not hear sound when playing back audio through Pro Tools hardware from QuickTime or Safari with the Digi CoreAudio
Manager, try one the following:
• Open the Mac System Preferences and click Sound. While QuickTime or Safari is playing back audio, change the Output from
Digidesign HW to Internal, and then back to Digidesign HW.
– or –
• Launch iTunes before launching QuickTime or Safari.
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Buffer sizes incompatible with Pro Tools hardware (39542)

In Cubase, Traktor, Live, and certain other applications, you can select Buffer Sizes that may be incompatible with your Pro Tools hardware. Selecting incompatible buffer sizes results in distorted sound and may cause other problems. Please make sure to select Buffer
Sizes listed in the following chart:
Cubase SX Buffer Sizes Supported by Avid Audio Hardware
Avid Audio Hardware

Supported Buffer Sizes

Avid HDX

128, 256, 512, 1024

Pro Tools|HD

128, 256, 512, 1024

HD Native

128, 256, 512, 1024

003, 003 Rack, 003 Rack+, Eleven Rack, Digi 002,
and Digi 002 Rack

64, 128, 256, 512, 1024

Mbox and Mbox 2-series interfaces

32, 64, 128, 256, 512, 1024

Reason Output distorts with Buffer Size settings less than 256 samples at 88.2 kHz or 96 kHz (39399)

Distorted sound can result when a Reason user has selected a Buffer Size of less than 256 samples at sample rates of 88.2 kHz or 96 kHz.
Pro Tools reports a –6101 error connecting or disconnecting headphones or audio cables from the audio output jack on your
computer while using Pro Tools (PTSW-159325)

You may encounter a –6101 error when connecting or disconnecting headphones or audio cables from the audio output jack on your
computer while using Pro Tools. To avoid this problem, quit Pro Tools before connecting or disconnecting your headphones or audio
cables.

Known Issues with Audio Interfaces
HD OMNI
Noise in the output signal from HD OMNI with digital input (PTSW-1614)

If HD OMNI is connected to a digital source with a mismatched clock and Sample Rate Conversion (SRC) is not enabled, you will hear
noise (including loud “pops”) in the output signal. To correct this problem, either enable SRC or ensure that the clock of the digital
source and HD OMNI are matched correctly.
HD OMNI front panel Setup menus are unresponsive after Pro Tools quits unexpectedly (PTSW-125692)

HD OMNI will not automatically recover “stand-alone” mode if Pro Tools quits unexpectedly (or if you disconnect the DigiLink cable
from HD OMNI while Pro Tools is running). As a result, some of the SETUP functions accessible from the front panel will be unavailable. Power cycle HD OMNI to recover stand-alone mode.
Graphic redraw problems in the Hardware Setup dialog (PTSW-122690, PTSW-1346, and PTSW-1235)

When changing the Hardware Setup configuration for HD OMNI, it is possible to encounter graphics redraw problems in some cases.
To force a graphics redraw of the Hardware Setup dialog, close and reopen the Hardware Setup dialog.
Versions of Pro Tools lower than 8.1 quit on launch with HD OMNI (PTSW-1976)

When launching versions of Pro Tools lower than 8.1 with HD OMNI connected and powered on, Pro Tools quits when initializing DSI.
To avoid the problem, power off HD OMNI before launching versions of Pro Tools lower than 8.1.
No sound on output after hardware reset (PTSW-126575)

After resetting the HD OMNI interface to the default factory settings using the front panel controls, the HD OMNI interface stops emitting sound in sessions where the outputs are not assigned to the Monitor output path. To correct this problem, press the ALT monitor
button to switch to the ALT Monitor path, and then press it again to switch back to the Main Monitor path.
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Loss of Monitor path when launching Pro Tools with HD OMNI off or disconnected (PTSW-127313)

When launching Pro Tools and opening I/O Setup after powering off HD OMNI or disconnecting it from the system, the inactive Monitor path is not present in Output tab. You may need to restore the default I/O Settings and remap the corresponding Output Busses.
Output paths are not automatically created in the Output page of the I/O Setup after disabling the corresponding Monitor path
in the Monitor page of the Hardware Setup and re-assigning the Outputs from “None” to physical outputs in the Main page of
the Hardware Setup (PTSW-127559)

After disabling the Monitor path in the Monitor page of the Hardware Setup and re-assigning the corresponding Outputs from “None”
to physical outputs (such as “A 1-2”) in the Main Page of the Hardware Setup, these Output paths are not automatically created in the
Output Page of the I/O Setup. You will have to manually create the appropriate Output paths in the I/O Setup (or click Default).
Changing Monitor path Output assignments in the Hardware Setup does not update the Output paths in the Output page of the
I/O Setup (PTSW-127563)

When changing Monitor path Output assignments in the Monitor page of the Hardware Setup (such as setting the Monitor path Format
to None or assigning the Monitor to different physical outputs), the Output paths in the Output page of the I/O Setup do not reflect the
corresponding changes. You will have to manually create the appropriate Output paths in the I/O Setup (or click Default).
When creating new sessions, using the I/O Settings selector can result in unexpected Output assignments if HD OMNI has an
assigned Monitor path (PTSW-123896)

If HD OMNI has an assigned Monitor path, Output paths created by the selected I/O Settings option in the New Session dialog may be
offset by the channel width of the Monitor path. If this happens, you will have to manually create the appropriate Output paths in the
I/O Setup (or click Default).
I/O Setup Bus page erroneously adds monitor paths (PTSW-127739)

With both MAIN and ALT Monitor paths declared, toggling one of the CR Monitor paths from the current format to “None” and then
back to the starting Monitor format from within the Hardware Setup Monitor page, causes the Bus page in I/O Setup to erroneously add
an extra Monitor path with the abbreviation with “(1).” This can happen numerous time and each new Monitor abbreviation increments
accordingly.

003 Family and 002 Series Interfaces
Upgrading to Lion can result in the uninstallation of Pro Tools components for Digi 002 and 003 family systems

If you upgrade from Mac OS X 10.6.x (“Snow Leopard”) to Mac OS X 10.7.x (“Lion”) with Pro Tools already installed,
DigiDioMIDIServer.plugin and DigidesignFireWireMIDI.plugin will be uninstalled during the Lion install. When the OS upgrade is
complete, a dialog will appear indicating that these files were moved to an Incompatible Software folder. You can reinstall the drivers
for your Digi 002 or 003 family interface after installation to restore these files.
To run Pro Tools on Mac OS X 10.7.x (“Lion”) with a Digi 002 or 003 family interface, Avid recommends that you create a clean Lion
partition and install Pro Tools directly to that partition.
Reconnecting an 003 or 002 after losing the connection with Pro Tools (PTSW-20351)

If your 003 family or 002 series interface looses its connection with Pro Tools, increasing your buffer size or changing your CPU usage
limit may bring the device back online without having to close Pro Tools or restart your computer.
Importing .PIM Files on an 003 System with a C|24 (PTSW-46401)

When importing a custom map .PIM file created on a 003 to another 003 system with a C|24, 003 displays “<No Track>” on the scribble
strips instead of staying in Plug-in Edit mode with a restored newly imported Plug-in Map. You will need to switch to another mode on
003 and then re-enter Plug-in Edit mode to correct this.
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Pro Tools Aggregate I/O (Mac Built-In Audio)
When using Aggregate I/O on Mac OS 10.7.x (“Lion”), a New Session command results in an error (PTSW-142151) or the
Aggregate I/O sample rate is frozen at a setting of 0 Hz (PTSW-142166)
If either of these errors occurs, do the following:
1

Quit Pro Tools.

2

Launch Audio MIDI Setup.

3

Choose Window > Show Audio Window.

4

Select Pro Tools Aggregate I/O.

5

Click the Minus sign icon to delete Aggregate I/O.

6

Relaunch Pro Tools.

–6101 error when previewing audio with Pro Tools Aggregate I/O (PTSW-132996)

When previewing audio in the Import Audio dialog with Pro Tools Aggregate I/O selected as the Current Engine (in the Playback Engine dialog), and with the Mac OS File view is set to Columns view, you may encounter a –6101 error. Try changing the Mac OS file
view from Columns to List or Icons view, or use any of the built-in audio devices instead of Pro Tools Aggregate I/O to avoid this problem.
Changing sample rates in Audio MIDI Setup can cause Aggregate I/O to disappear in I/O Setup, resulting no audio output
(PTSW-132281)

When Pro Tools Aggregate I/O is selected as the Current Engine in the Playback Engine dialog, changing sample rates in Audio MIDI
Setup can cause the Pro Tools Aggregate I/O to be removed from I/O Setup resulting in no audio output. To correct this problem, click
the Default button on the Output page of the I/O Setup.
Error messages when opening a session with a different sample rate from the Aggregate I/O sample rate setting (PTSW-131779)

Pro Tools may indicate that a given Aggregate I/O device has not automatically adjusted its sample rate when a session with a different
sample rate is opened. You may subsequently be presented with a dialog indicating that the session needs to be closed and reopened to
update the sample rate setting of the Aggregate I/O device.
Renaming Pro Tools Aggregate I/O driver in AMS corrupts the driver (PTSW-131383)

If you rename the Pro Tools Aggregate I/O driver in Audio MIDI Setup (AMS), the driver be corrupted the next time you launch Pro
Tools. If this happens, quit Pro Tools and delete the Pro Tools Aggregate I/O device from AMS. Pro Tools will re-create the driver the
next time it is launched.
Pro Tools quits unexpectedly when enabling the built-in digital I/O (PTSW-132189)

When enabling built-in digital I/O for Pro Tools Aggregate I/O in Audio MIDI Setup, Pro Tools quits unexpectedly. To avoid this problem, enable the built-in digital I/O in Audio MIDI Setup before launching Pro Tools.

Third-Party Core Audio Devices
Pops and clicks can occur when using third-party Core Audio devices with Pro Tools (PTSW-132084)

Note that audible pops and clicks can occur when using some third-party audio interfaces even if Error Suppression is disabled. Try increasing the Hardware Buffer size for the device to avoid this problem.
Using low buffer sizes with Studio Monitor Express may result in Pro Tools quitting unexpectedly with a loud burst of noise
(PTSW-132513)

Using Studio Monitor Express with some Core Audio Devices may result in Pro Tools quitting unexpectedly along with loud bursts of
noise. Studio Monitor Express is not recommend for use with Pro Tools at this time.
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Error Messages
Error –1150 (PTSW-144422)

When launching Pro Tools HD on HDX hardware, if you encounter a –1150 error, quit Pro Tools, shut down your computer, and ensure
that the HDX TDM cable is properly connected.
Error –6042

If you repeatedly encounter –6042 errors, open the System Usage window and check the PCI gauge. If the gauge is peaked, you will
need to reset the PCI bus. To reset the PCI bus, make all tracks inactive and start playback. If you still encounter a –6042 error, quit and
relaunch Pro Tools, open the Playback Engine dialog, and change the Number of Voices setting to use fewer voices per DSP.
Error –9073 without reaching the 2 GB file limit

If you encounter a –9073 error, and you have not reached the 2 GB file size limit, please refer to the Knowledge Base for possible causes
and solutions (www.avid.com/onlinesupport).
Error –9128

In sessions with high sample rates (96 kHz or higher), you may need to set the Hardware Buffer Size to 512 or more to avoid –9128 errors during playback with Native (RTAS and AAX) plug-ins or dense automation.
Error –9131 (92747, 20843)

GUID partitioned drives will not allow you to record beyond the third partition when running on OS X. A workaround is to partition audio drives using Apple Partition Map instead of GUID.
– or –
Recording to or playing from a UNIX File System (UFS) formatted drive is not supported in Pro Tools.
Error –9132 (32397)

If a –9132 error occurs during Bounce To Disk (even with the highest Hardware Buffer setting selected), bus the appropriate tracks to
the appropriate number and format of audio tracks, and record to disk. You can then use the resulting audio files as you would have used
bounced files.
Error –9155

In sessions with high sample rates of 96 kHz or more, you may need to set the Hardware Buffer Size to 512 or more to avoid –9155 errors during playback with dense automation.
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